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Safety and Regulatory 
Compliance
The Gel DocTM EZ imager is intended for laboratory use only. This instrument is meant for 
use only by specialized personnel who know the health risks associated with the reagents 
normally used with this instrument. 

The UV light source is computer controlled, and proper interlocks are implemented to 
avoid users’ accidental exposure to UV radiation.

If the Gel Doc EZ imager is used in a manner not specified by Bio-Rad Laboratories, the 
protection provided by the Gel Doc EZ imager may be impaired.

To help you make informed decisions about safety, we have provided comprehensive 
operating procedures and safety information in this manual and on labels affixed to the 
imager. This information will alert you to any potential hazards. It is the user’s 
responsibility to read and understand the safety information and use it for safe operation 
of the system.

Safety Use Specifications and Compliance
The Gel Doc EZ imager is designed and certified to meet EN61010, the internationally 
accepted electrical safety standard, and EN61326 Class A EMC regulations. Certified 
products are safe to use when operated in accordance with the instruction manual.

This instrument should not be modified or altered in any way. Modification or alteration of 
this instrument will:

• Void the manufacturer’s warranty 
• Void the regulatory certifications 
• Create a potential safety hazard

 Gel Doc EZ imager certification label
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For easy customer access, the serial number information appears in two locations on your 
instrument: on the back panel and inside the front door.

Instrument Safety Warnings
Notes, cautions, and warnings are used to highlight certain operating procedures and 
recommendations. The table below describes how each is used in this document.

NOTICE

The Gel Doc EZ imaging system is intended for laboratory use only. This system is meant 
for use by specialized personnel who know the health risks associated with reagents 
normally used in electrophoresis. The UV light source is computer controlled, and proper 
interlocks are implemented to avoid users’ accidental exposure to UV radiation. Bio-Rad 
Laboratories, Inc., is not responsible for any injury or damage caused by use of this 
instrument for purposes other than those for which it is intended or for instrument 
modifications not performed by Bio-Rad Laboratories, Inc., or an authorized agent.

WARRANTY

Each Gel Doc EZ imaging system is protected by a comprehensive instrument warranty 
agreement. Please read this manual thoroughly so that you fully understand the coverage 
provided and are aware of your rights and responsibilities. One of the responsibilities of 
system ownership is regular maintenance. Following the maintenance instructions 
provided with this manual will help keep your system and peripherals functioning optimally 
and will protect your investment. Please also keep in mind that Bio-Rad offers a range of 
comprehensive service agreements that can be tailored to meet your specific needs. Bio-
Rad Laboratories is dedicated to your total satisfaction and will be pleased to answer any 
questions you may have.

Notes, Cautions, and Warnings

Icon Meaning

Note: Note: A note indicates a special procedure, an exception to normal 
operation or something else of specific interest to the reader. Notes are 
preceded by the word Note. 

Caution: A caution precedes an operational step that could damage the 
instrument or destroy data unless the operator takes certain precautions. 
Cautions located in the main text are preceded by the word Caution and 
are accompanied by the Caution symbol in the left margin.

Warning: A warning precedes an operating procedure that could cause 
injury to the operator if not followed correctly. Warnings located in the main 
text are preceded by the word Warning and are accompanied by the 
Warning symbol in the left margin.
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CAUTIONS

WARNINGS

Caution: With the exception of cleaning or replacing light bulbs, 
refer all servicing to qualified Bio-Rad personnel or their agents. If 
you experience technical difficulties with the instrument, contact 
Bio-Rad to schedule service. The instrument should not be 
modified or altered in any way. Alteration voids the manufacturer’s 
warranty and may create a potential safety hazard for the user.

Caution: If the case interlock is defeated, there is a possibility of 
UV-B radiation hazard due to UV-B light exposure. Caution must 
be exercised when servicing the instrument. 

Caution: Bio-Rad is not responsible for any injury or damage 
caused by the use of this instrument for purposes other than that 
for which it is intended, or by the modification of this instrument 
when not performed by qualified Bio-Rad personnel or their 
agents.

Caution: Disconnect the AC power cord before removing the instrument 
cover.

Warning: This instrument must be connected to an appropriate AC 
voltage outlet that is properly grounded.

Warning: There are hazardous voltages on the inside of the  
Gel Doc EZ. Do not remove the system cover when the instrument 
is connected to AC power.

Warning: Do not defeat instrument interlocks; they are designed to 
prevent user injury.

Warning: The Gel Doc EZ imager contains high voltage circuits. 
The user must disconnect the power cord prior to opening the 
system cover or removing the lamp modules for bulb replacement.

Warning: It is mandatory for users to turn off the imager and 
disconnect AC power from the unit before performing disassembly, 
as is needed to replace the lamps.

Warning: Do not remove the instrument cover when power is supplied to 
the instrument or defeat the UV safety interlock. Attempting to operate the 
unit with the cover removed may damage the instrument and expose the 
operator to hazardous voltages and UV radiation.

Warning: Use of controls or adjustments or performance of procedures 
other than those specified herein may result in exposure to hazardous UV 
radiation.



Gel DocTM EZ System | Safety and Regulatory Compliance

x



System Overview

1

1 System Overview
This manual describes the Gel DocTM EZ system, which consists of the Gel 
Doc EZ imager and Image Lab™ software.

The Gel Doc EZ system supports multiple applications, including Coomassie 
and Ethidium Bromide staining, Blue excitation for nondestructive DNA 
visualization, and stain-free gel imaging. 

When coupled with the stain-free gel tray, the Gel Doc EZ system represents 
the next generation in stain-free imaging. It features one button acquisition, 
yields quick results with higher image quality, and is so simple to use it 
requires no training, even for users who are not familiar with image analysis 
systems. The Gel Doc EZ system’s compact size frees up bench space, 
saving real estate for running your experiments.

The Gel Doc EZ system is a reproducible and fast label-free SDS-PAGE/native 
PAGE system that eliminates time-consuming staining and destaining steps. 
Image Lab image acquisition and analysis software works with the Gel Doc EZ 
imager to create an automated and time-saving system to image and analyze 
electrophoresis gels. Data can be viewed, modified, and reported using Image 
Lab software.

Image Lab software protocols can automate gel image acquisition, analysis, 
and report generation at the push of a single button on the imager.

Researchers can run default protocols they set up or easily design their own 
custom protocols. Image Lab software enables you to view analyzed data, 
adjust the analysis, and produce customized reports that show precisely the 
settings that were applied, assuring repeatable results.
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Gel Doc EZ Imaging System
The Gel Doc EZ imaging system is a dedicated low-noise detection camera 
and UV transilluminator–based system with a small footprint. Designed for 
economy, automation, and ease of use, the user interface consists of a set of 
four sample trays and a one-touch button to image your gel using a protocol. 

Gel Doc EZ imaging system, catalog #170-8270
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Four sample trays are available for the Gel Doc EZ imaging system. Each tray 
supports a different set of applications, as shown in the table. 

Sample tray types and applications 

UV Tray
PN 170-8271

White Tray
PN 170-8272

Blue Tray
PN 170-8273

Stain-Free Tray
PN 170-8274

Ethidium bromide Fast Blast™ DNA 
stain

SYBR® Green stain-free gels

SYBR® Green Coomassie Blue 
stain

SYBR® Safe stain-free blots

SYBR® Safe Copper stain SYBR® Gold

SYBR® Gold Zinc stain GelGreen

GelGreen Silver stain

GelRed

Flamingo 
fluorescent gel stain

Oriole fluorescent 
gel stain

Coomassie Fluor 
Orange

SYPRO Ruby

Krypton
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Image Lab Software Capabilities
Image Lab software runs automated protocols on the Gel Doc EZ system for 
routine gel imaging documentation and analysis.

GEL DOCUMENTATION

Gel electrophoresis is a common way to separate, identify, and purify proteins 
or nucleic acids. The Gel Doc EZ system enables users to image and print gel 
images for documentation in laboratory notebooks or to export images for 
publication or presentation.

MOLECULAR WEIGHT ASSESSMENT

SDS-polyacrylamide gel electrophoresis (SDS-PAGE) and agarose gel 
electrophoresis are used to separate proteins or nucleic acids according to 
their size. Protein or nucleic acid molecular weight standards provide a 
reference for estimating the molecular weight of the proteins or nucleic acids 
being tested.

QUANTIFICATION

The components in a sample (bands) are quantified to determined relative 
amounts of each component in a sample or to compare the amount of a 
sample component relative to a standard. Assessing the purity of a sample is 
one application that uses quantification of all components of a sample relative 
to each other.  Results are expressed either as percent of all bands identified 
(band %) or as a percent of all signal in the sample lane (lane %). Determining 
expression levels of a protein or nucleic acid is an application where 
quantification among samples is required. Data can be reported as either 
relative values, if the quantity is unknown, or as an absolute value, if a 
standard of known quantity is present.
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2 Configuring the System 
Configuring the system requires the following steps, all of which are described 
in this chapter:

1. Install Image Lab™ software on the PC or Macintosh computer you 
intend to use with the imager.

2. Connect the Gel DocTM EZ imager to the computer.

3. Configure the imager.

Installing Image Lab Software

Windows 
1. Place the Image Lab software CD in your CD-ROM drive. The 

installation should start automatically. If it does not, open My Computer 
and click the CD drive icon. 

2. Double-click setup.exe. The setup program installs Image Lab software 
on your computer.

The Image Lab software icon appears on your desktop. Follow the 

instructions in the next section to connect your system.

Macintosh
1. Place the Image Lab software CD in your CD-ROM drive.
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2. Double-click the CD icon on your desktop to see the folder contents. 

3. Double-click the file Image Lab.dmg.

4. Drag the Image Lab application icon into the Applications folder.

Follow the instructions in the next section to assemble your system.

Connecting the Imager to the Computer
1. Install or upgrade the Image Lab software before connecting the Gel 

Doc EZ imager to a computer. 

2. Connect the imager to the computer using the USB cable provided with 
the system.

3. Connect the Gel Doc EZ to AC power using the power cord provided. 

USB cable

Rear of imager

Computer

AC

Power
cord
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4. Turn on power to the imager using the switch on the side of the 
instrument. 

If Your Computer is Running Windows XP
After the power is turned on, the PC automatically recognizes the imager, and 
the software prompts you to install the drivers. The screen below appears:

5. Select No, not this time, and then select Next. 

Power
switch
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The following screen appears:

6. Install the software automatically is selected by default.  
Click Next. 

The following screen appears:

7. Click Continue Anyway. Windows installs the driver.
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8. Click the Finish button when it appears. A message appears briefly in 
the lower right corner of the screen: Your new hardware is ready to use.

Note: Windows XP may prompt you to go through the driver 
installation a second time. If this happens, repeat steps 5  
through 8 until you receive the message: Your new hardware is 
ready to use.

WINDOWS 7
During the installation process the following warning may appear. This 
warning can be ignored because it appears even when the driver has been 

installed correctly.

Configuring the Imager
To use the imager with Image Lab software, the imager must first be 
configured. Imager configuration consists of initializing the sample trays and 
collecting the dark image. 

The imager is configured in the setup wizard, which appears the first time the 
imager is connected to a computer.

To configure the imager:
1. Turn on the imager and start Image Lab software. The setup wizard 

appears. 

2. Complete the steps in the wizard, which are described next.

Note: You must go all the way through the wizard or the imager will 
not be usable.
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The first page of the setup wizard 
indicates that a new instrument has 
been found on the system and displays 
the instrument’s serial number.

1. Click Next.

The Dark Image Correction page 
appears. Correcting the dark image 
reduces dark current noise generated 
from the charge-coupled device (CCD). 
Dark current noise is typical of all CCDs 
and is a result of the accumulation of 
charge in the absence of light.

2. If a tray is in the imager, remove it 
and close the tray door.

3. Click Acquire Dark Image.

A progress indicator reports the 
acquisition of the dark image.

When the dark image has been 
acquired, the wizard prompts you to 
initialize the UV tray. 

4. If you do not have a UV tray, click 
Skip and go to step 7.

5. Make sure the UV tray is clean. Then 
insert the tray into the imager and close 
the door.

A progress indicator reports the 
initialization of the tray.
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When the tray has been initialized, the 
next page confirms that the tray has 
been found and initialized and lists the 
applications you can run with this tray. 

6. Remove the UV tray from the imager. 
Then click Next.

The wizard prompts you to initialize the 
white tray. 

7. If you do not have a White tray, click 
Skip and go to step 10.

8. Make sure the white tray is clean. 
Then insert the tray into the imager and 
close the door.

A progress indicator reports the 
initialization of the tray.

When the tray has been initialized, the 
next page confirms this and lists the 
applications you can run with the tray. 

9. Remove the white tray from the 
imager. Then click Next.
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10. The wizard prompts you to initialize 
the blue tray. If you do not have a blue 
tray, click Skip and go to step 13.

11. Make sure the blue tray is clean. 
Then insert the tray into the imager and 
close the door.

A progress indicator reports the 
initialization of the tray.

When the tray has been initialized, the 
next page confirms this and lists the 
applications you can run with the tray. 

12. Remove the blue tray from the 
imager. Then click Next.

13. The wizard prompts you to initialize 
the stain-free tray. If you do not have a 
stain-free tray, click Skip and go to step 
16.

14. Make sure the stain-free tray is 
clean. Then insert the tray into the 
imager and close the door.

A progress indicator reports the 
initialization of the tray.
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See Chapter 4, Acquiring Images, on page 29, to configure the default 
protocols that run when the green button on the imager is pressed.

When the tray has been initialized, the 
next page confirms this and lists the 
applications you can run with the tray. 

15. Click Next.

A tray summary page lists all the trays 
and their status. Trays you initialized 
appear as ready to use. 

16. Click Finish to exit the wizard.
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Initializing an Additional Tray
After you configure the imager, you can add another tray to the system when 
you need it. 

To initialize an additional tray:
1. Insert a new type of tray in the imager. The New Tray Found wizard 

opens.

2. Complete the steps in the wizard.

The wizard identifies the new tray 
and asks whether you want to 
initialize it.

1. Click Next.

The wizard begins initializing the tray.
A progress indicator reports the 
initialization of the tray.

When the tray has been initialized, 
the wizard displays a list of the 
applications you can run using the 
tray.

2. Click Next.
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The wizard displays the Tray 
Summary, which shows the 
highlighted, initialized new tray.

3. Do one of the following:

Click Finish to leave the wizard and 
display the Default Protocol Setup 
dialog box, where you can start 
creating a default protocol for the 
new tray.

OR

Clear the checkbox at the bottom of 
the wizard page to skip setting up a 
default protocol. Then click Finish to 
leave the wizard.
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3 Image Lab™ Software 
Overview
Image Lab image acquisition and analysis software works with the Gel DocTM 
EZ imager, stain free gels, and other gels that are not stain-free to create a 
reproducible, automated, and time-saving workflow for running gels. 

In Image Lab software, a protocol is any combination of imaging, analysis, 
and report settings that has been saved to run as a single workflow. 
Researchers can run one protocol repeatedly or easily design a wide range of 
protocols. 

With Image Lab software you can view analyzed data, edit the analysis, and 
produce customized reports that show the precise settings that were applied 
to ensure repeatable results. 

Two types of files are generated by Image Lab software:
• Protocol files describe the parameters for imaging and analyzing 

gel images. Protocol files are saved with a .ptl extension
• Image files contain the imaged gel, annotations, and analysis 

performed on the gel. Image files are saved with an .scn extension 

An imaged gel, run according to a protocol file, generates an image file. 
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Imaging Process Overview 
You can image your gel on the Gel Doc EZ imager by running a default 
protocol or a custom protocol. You can set up default protocols for the gels, 
applications, and analyses you are likely to run repeatedly. Then you can 
access them with a touch of a button on the front of the imager. For gels and 
applications you run less frequently, you can set up custom protocols that you 
can call and run with a software command. Both default and custom 
protocols can be saved and reused.

Default Protocols
Image Lab software supports four default protocols, one for each type of 
available sample tray. First, set up a default protocol for the kind of application 
you want to run. Then, run the default protocol, which activates and images 
the gel with one touch of a button. See Setting Up a Default Protocol, on 
page 31 for detailed instructions. 

To run a default protocol:
1. Open the imager door and remove the sample tray.

2. Place your gel on the sample tray and insert it 
into the imager until the magnet grabs the tray.

3. Close the door. 

4. Press the green Run button on the front panel of 
the imager. The default protocol runs 
automatically.

Run button
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Custom Protocols

You can set up additional custom protocols based on your exact 
requirements. Setting up a custom protocol is similar to setting up a default 
protocol. 

To run a custom protocol:
1. Open the imager door and remove the sample tray.

2. Place the gel on the sample tray and insert it into the imager until the 
magnet grabs the tray.

3. Close the door.

4. Click New in the Protocols box on the Image Lab Start Page, or click 
New Protocol in the toolbar. 

5. Select the parameters for your protocol. See Running a Custom 
Protocol, on page 45 for detailed information.

6. Click the green Run Protocol button in the left pane of the Protocol 
Setup dialog box to run the protocol.

Using the protocol you specified, the software controls the imager to 
activate the sample, analyze the image, and then generate and print a 
report.
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Interface Overview

The following illustration shows the Image Lab software main window. The 
paragraphs below describe the main software elements.

Main Window
Image Lab software displays a single main window. All image and protocol 
dialog boxes that present choices open in the workspace, which is the gray 
area of the main window. 

If many screens are open in the workspace, you can make one visible by 
clicking the title bar at the top of the selected screen. A list of open protocols 
and image files also appears in the Window menu; you can select one to bring 
it to the top.

You can view the complete analysis for an image or protocol at one time or 
compare image results by arranging the screens in the workspace.

 

Toolbar

Analysis
Start page

Workspace

Status bar

Menus 

tool box
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Toolbar
Many Image Lab software tools can be selected by clicking toolbar icons. The 
Snapshot tool enables you to send a screen capture of your image to the 
clipboard or to save it as a file. You can view demonstrations of various 
functions by clicking Tutorials. The unlimited Undo and Redo buttons enable 
you to correct missteps easily. 

Clicking the green Default Protocols button at the right end of the toolbar 
displays the Default Protocol dialog box for setting up, viewing, and editing 
default protocols.

Additional tools for viewing protocols and results data presented in various 
forms are labeled below. These tools are described in detail in Chapter 6, 
Viewing Images, on page 47.

Results Data
Results data associated with gel images can be viewed as an analysis table, a 
lane profile, a standard curve, or in a report. These views always display the 
analysis for the selected image. 

Buttons to toggle these views on and off are located in the main toolbar, as 
shown. All of them can be viewed at once. See Displaying Data, on page 54 
for details.

File management View results data
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Display Toolbox
The Display Toolbox near the top of every image enables you to display your 
images in the most useful ways. See Displaying Gel Images, on page 48 for 
details.

Start Page
The Start Page guides you through creating, opening, and viewing protocols 
and images.
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Analysis Tool Box

The Auto Analysis  button quickly 
analyzes images. 

The remaining tools customize the analyzed data.

Note: An image file must be selected (on a Windows 
computer, the title bar is dark blue) to make analysis 
tools available.

Image Tools enable you to flip, rotate, and crop images, 
and to transform the image files. 

Lane and Band controls the detection function, enabling 
you to resize, adjust, and bend lanes, and to detect, adjust, 
add, or delete bands.

MW (Molecular Weight) Analysis Tools enable you to 
choose standard samples, assign standard lanes, and 
choose a regression method.

Quantity Tools enable you to automatically quantitate 
bands using either relative or absolute values.

Annotation Tools are useful for drawing attention to any 
area of a gel of interest. 

Volume Tools enable you to manually quantify an object 
inside a boundary that you define. 

Analysis tools are described further in Auto Analysis 
Settings, on page 61.

 

Click to
hide
toolbox
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Status Bar

The status bar in the lower right corner of the main window shows the tray and 
imager in use and the X and Y values for the cursor position on an image file. 
If a default protocol has been set up for the tray in use, its name also appears 
in the status bar next to the tray name. The Int (intensity) value shows a 
numerical value for the image intensity at the mouse position. The maximum 
data range using the Gel Doc EZ imager is 0–4,095, but the ranges vary 
depending on the values contained within each image.

Menu Commands
The following section describes all menu commands in the File, Edit, View, 
Window, and Help menus. Many commands are also available on the toolbar 
or the Start Page.

File Menu Commands
New Protocol enables the user to create a new protocol that contains the 
necessary steps and choices. See Chapter 4, Acquiring Images, on page 29, 
for detailed instructions. Protocols can also be altered and stored for reuse. 

Open browses the user’s file system to retrieve a previously saved protocol 
file or image file.

Recent Images gives the user the choice of opening a recent image file.

Recent Protocols gives the user the choice of opening a recent protocol.

Save enables the user to save a protocol or image file once the protocol or 
image is named.

Save As enables the user to name and store a protocol or image. Protocols 
are stored with a .ptl file extension. Image files are stored with an .scn 
extension.
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Close closes the active screen.

Close All closes all the screens.

Export enables the user to export gel images or analysis tables with the 
following options:

• Export for Publication—Exports a displayed image to a file. You 
can select from .bmp, .png, .jpg, and TIFF formats. The gel 
displays with any lanes, bands, and annotations that appear on the 
screen. See Exporting Gel Images for Publication, on page 86 for 
more information.

• Export for Analysis—Creates a TIFF formatted file that retains all 
gel image data. Analysis data are not included. Use this option to 

analyze the image in other software such as Quantity One, 

FPQuest™, or InfoQuest™FP. See Exporting Gel Images for 
Analysis, on page 87 for more information.

• Export for PulseNet—Reduces the image to an 8-bit TIFF image 
file. Resolution is limited and file size is restricted to 300 dpi.

• Lane and Band Table to Excel—If Excel (or Numbers, on a Mac) is 
installed on your computer, it will launch with your lane and band 
table displayed as a spreadsheet.

• Lane and Band Table to File—Exports as a CSV (comma-
separated values) file so your lane and band table can be opened in 
a database application.

• Volume Table to Excel—If Excel or Numbers on a Macintosh is 
installed on your computer, it will launch with your volume table 
displayed as a spreadsheet.

• Volume Table to File—Exports as a CSV (comma-separated 
values) file so your volume table can be opened in a database 
application.

See Chapter 8, Exporting Results, on page 85 for detailed information about 
exporting files.

Image Info displays information about individual gel and blot images such as 
acquisition date, data range, and image capture details such as the exposure 
time and illumination source used in three tabs (Image Details, Analysis 
Settings, and Notes).
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Page Setup contains print controls such as orientation (landscape or portrait), 
margins, printer used, and paper size.

Print displays a print preview of the gel and the header information, which 
includes the filename of the image, the user’s name, and date and time it was 
printed. The usual Windows Print screen is available as well; it enables you to 
select a printer and the number of copies.

Exit closes Image Lab software (after asking you to save changes to your 
protocols or images). 
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Edit Menu Commands
Undo undoes the last user action.

Redo restores the last user action after an Undo.

Snapshot enables the user to take a screen capture of the Lane Profile 
Window, the Standard Curve Window, or the default choice, Current Image 
View. This capture can include the name of the image, and it can be placed on 
the clipboard or saved in a file.

Default Imager enables users who own two or more different model imagers 
to switch among them.

Instrument Setup enables users to review the instrument name and serial 
number, camera serial number, firmware version, and the flat field version. 
Available sample trays are shown with the names of associated default 
protocols. Dark Image time and date are also shown. You can reset the dark 
image. You can reset the flat field only for the white sample tray.

Report Settings enable users to configure reports. This dialog box displays 
three tabs. All the checkboxes are selected by default; clear the boxes for 
information you do not want to include in reports. Your selections apply to all 
reports until you change them again.

• The General tab has options for excluding or reporting information 
about the gel image.

• The Lane and Band Table tab enables the researcher to choose 
whether to include all or selected lanes with appropriate identifiers. 
Lane profiles can also be included.

• The Volume Table tab enables the researcher to choose 
appropriate identifiers for the volume table and provides the option 
of excluding the table from reports.

Preferences displays two tabs.
• The Protocol tab shows presets for naming your image files. You 

can choose to include a designated Prefix, User Name, Date and/
or Time in the name of your image files.

• The Colors tab enables you to choose colors for the graphic 
elements in your gels such as Lane Frame, Lane, Band, Band 
Attribute, and MW Legend. This functionality ensures that these 
elements are visible, regardless of the color of the gels.
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View Menu Commands
Image Overview opens a small window that shows the entire gel image with 
a red rectangle outlining the area visible in the larger main window. This is 
useful when you zoom into a small section of your image.

Image Transform opens a window showing a histogram, with which to adjust 
the light and dark values of your gel image. This adjustment does not change 
your data, only the way the data display on your monitor.

Operations History opens a window showing the sequence of actions 
performed by both the user and the software.

Window Menu Commands
The Window controls enable you to show and hide multiple open image files 
in your workspace. A list of all currently open images and protocols displays in 
this menu.

Tile aligns all open image files so all are visible at once.

Tile Horizontal places all open image files from top to bottom.

Tile Vertical places all open image files from left to right.

Cascade stacks all open image files and protocols with overlapping title bars 
so that each one can be easily chosen for view.

Imitate Zoom changes the zoom setting of all open images to the same zoom 
setting as the current image file.

Imitate Transform changes the brightness and contrast of all open images to 
the same transform settings as the current image file.

Next cycles through all open image files from oldest to newest.

Previous cycles through all open image files from newest to oldest.

Help Menu Commands
Image Lab Help displays the help system. 

User Guide displaysthis  instruction manual in .pdf form.

About displays Image Lab software version information and release date.
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4 Acquiring Images
Acquiring an image requires a set of steps in a workflow called a protocol. In 
Image Lab software, a protocol can include any combination of settings for 
imaging, analyzing, and reporting that has been saved to run as a single 
workflow. 

Users can link a protocol to a tray type by default. Such a default protocol is 
associated with: 

• A specific type of sample tray

• The green Run button on the front of the Gel DocTM EZ imager
• The user’s computer system login ID

The advantage of a default protocol is that it can be run with a single press of 
the green Run button on the imager. Custom protocols are run by clicking a 
software button in Image Lab software. In all other respects, default protocols 
and custom protocols are similar. 

Typically, a default protocol is set up for the applications a user runs most 
often with a particular tray. Each user can set up four default protocols (one 
for each type of sample tray) to run applications. A custom protocol can be 
set up for less frequently run applications tp capture the setup steps for later 
use.

Once set up in Image Lab software, a default protocol is run by placing a gel 
in a sample tray, inserting the sample tray, and pressing the green Run button 
on the front of the imager. The imager automatically runs the default protocol 
assigned to the type of sample tray you inserted.



Gel DocTM EZ System | Acquiring Images

30

If you have only one sample tray, it will automatically be considered the default 
sample tray. For example, suppose you have only a blue tray. Once the blue 
tray has been associated with the imager, Image Lab software will list all 
applications that can run on the blue sample tray. 

Selecting a Sample Tray
The following tables list preset applications and the appropriate sample tray to 
use with each. Refer to these tables to select a sample tray for your 
application. If your application is not listed here and you are unsure of the 
appropriate sample tray to use for your application, contact Bio-Rad Technical 
Support for assistance.

Applications for Nucleic Acid Gels

Applications for Protein Gels

Detection Reagent
Primary 
Tray

Alternate 
Tray

Ethidium bromide UV None

SYBR® Green Blue UV

SYBR® Safe Blue UV

SYBR® Gold Blue UV

GelGreen Blue UV

GelRed UV None

Fast Blast™ DNA stain White None

Detection Reagent Tray

Stain-free gels Stain-free

Stain-free blots Stain-free

Coomassie Blue stain White

Copper stain White

Zinc stain White

Flamingo™ fluorescent gel stain UV

Oriole™ fluorescent gel stain UV

Silver stain White

Coomassie Fluor Orange UV

SYPRO Ruby UV

Krypton UV
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Setting Up a Default Protocol
Setting up a protocol consists of three major processes: 

• Acquisition settings 
• Analyze image
• Report settings 

Each process comprises a set of steps. The appropriate options appear as 
each protocol step is selected. 

Important: You must configure Acquisition Settings (steps 1 
through 6 in the following procedure) to run an application. 
However, it is not necessary to configure Analyze Image and 
Report Settings unless you want to calculate the molecular 
weight automatically and generate a report.

To set up a default protocol:
1. Click the Default Protocols button in the toolbar to set up a default 

protocol.

Caution: If the imager is not connected to your computer, 
a message appears asking whether you want to run a 
simulation of the imager. Click No. Turn on the imager. Do 
not set up a protocol in simulation mode. Protocols set up 
in simulation mode cannot be run.
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A Default Protocol Setup dialog box displays each sample tray type as 
well as buttons that enable you to create a protocol or browse an 
existing protocol. Trays that have not been initialized appear dimmed. 
Note that once you create a default protocol, its Create button changes 
to View/Edit so you can review or change the protocol settings.

2. Click the Create button next to the sample tray type for which you want 
to create a protocol. The first Protocol Setup dialog box appears. The 
title bar identifies the protocol as a default protocol. The imager type 
and sample tray type are also shown. 
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The three major processes are listed in the left pane. Numbered major 
steps in each process appear under these headings. To select options 
under a protocol step, select the accompanying checkbox. Options 
appear in the right side of the dialog box. To disable any step, clear its 
checkbox.

Acquisition Settings

STEP 1. GEL IMAGING

The Gel Imaging checkbox is already selected. The right side of the 
Protocol Setup dialog box displays Gel Imaging options. 
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APPLICATION OPTIONS

3. Select an application: Click Select and choose an application from the 
drop-down menus. 

The menus list only applications appropriate for the selected sample 
tray. When you choose an application, any required filter or illumination 
source displays in the Protocol Setup dialog box.

Note: Custom applications are available only for custom 
protocols. See Setting Up a Custom Protocol, on page 43 for 
more information about custom applications.

4. Set the image exposure 

If you select the first image exposure option, Image Lab software 
acquires an image using the optimal exposure time. This option ensures 
the best use of the dynamic range. You can automatically optimize for 
intense or faint bands.

• If you choose Intense Bands from the drop-down menu, 
exposure is optimized for all bands

• Choosing Faint Bands from the drop-down menu results in a 
longer exposure where faint bands are more visible, but more 
prominent bands may be overexposed

• Select manual exposure to override automated imaging. 
Exposure time can range from 0.001 to 10 sec



Setting Up a Default Protocol

35

After a gel is imaged with automatic exposure optimization, the used 
exposure time displays in the protocol as a guide so you can manually 
adjust the exposure time if necessary.

You can also view the exposure time of the image later in the Image Info 
window (refer to Image Info, on page 53).

5. Set the Display Options:

Highlight saturated pixels—Select the Highlight saturated pixels 
checkbox to see any saturated pixels in red, which shows how much of 
the gel image is saturated. Saturated pixels are beyond the maximum 
quantifiable range of the imaging system. This option can be changed 
later by selecting View > Image Transform.

Image Color—Select color choice to display the sample image. 
Viewing the image with a different color scheme can make it easier to 
see all of the elements. See Image Colors, on page 51 for the color 
choices.

Analyze Image

STEP 2. DETECT LANES AND BANDS

To analyze the gel automatically, Image Lab software must detect lanes 
and bands on the image. Lanes are detected automatically, and then 
the background is automatically subtracted. Refer to Lane and Band 
Tools on page 65 for details. You can customize band detection with the 
following options.
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6. Select the Lane and Band Detection checkbox in the left pane of the 
Protocol Setup dialog box. The Protocol Setup dialog box displays lane 
and band detection options.

Low Band Detection Sensitivity—This option sets detection at a low 
level for images with prominent bands. Faint bands are not detected.

High Band Detection Sensitivity—This option sets detection at a 
higher level for images that are faint. Extraneous bands can be removed 
later using the Band Tools in the Analysis Tool Box. See Lane and Band 
Tools, on page 65.

Custom—Select a numerical value between 1 and 100 to choose the 
best detection sensitivity for your sample

When low or high band detection sensitivity is used, these numerical 
values are set: low sensitivity = 25; high sensitivity = 75
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STEP 3. ANALYZE MOLECULAR WEIGHT

7. To analyze molecular weight automatically, select Analyze Molecular 
Weight in the left pane of the Protocol Setup dialog box. When this 
checkbox is selected, the software calculates the molecular weight for 
each band based on the specified standard.

8. To estimate the size of the molecules in the bands of your gel, enter the 
standards you are using and specify the lanes in which the standards 
are placed.
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STANDARDS

Determining molecular weight depends upon selection of the proper 
protein standards. Many protein standards are available from Bio-Rad, 
including:
• Precision Plus Protein™ standard
• Prestained SDS-PAGE standards, broad range
• Prestained SDS-PAGE standards, low range
• Prestained SDS-PAGE standards, high range

Bio-Rad standards cannot be edited. However, these standards can be 
copied, and the copies can be renamed and edited.

The Change button opens the Manage Standards dialog box in which 
you can add third-party standard samples and edit your list.

STANDARD LANES

9. Choose which lane contains your standards by typing lane numbers or 
the words First and Last in the Standard Lanes field. The format is xx, 
xx, xx, ... where xx is the lane number. For example, if you run an 18-
well gel and want your standards in lanes 1, 10, and 18, enter First, 10, 
and Last.

Note: Lane detection works best when standards are placed in 
the first and last lanes.
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REGRESSION METHODS

A regression method is used to calculate the molecular weight of the unknown 
bands. The software uses the relative front and molecular weight values of the 
standard bands to calculate the standard curve. The standard curve is then 
used to calculate the values of the unknown bands. The shape of the standard 
curve is based on the selected regression method. Choose one of four 
regression methods. 

The methods and the minimum number of standard bands required for each 
type are shown in the following table.

If you do not have enough data points for the selected method, the molecular 
weight of the unknown bands is not calculated.

10. Select the appropriate method for the gel type:
• Gradient gels: The linear (semilog) regression method works 

well for these gels because the mobility of the bands is linear to 
the log of their molecular weight. As an alternative, the point-to-

point (semilog) method can be used if the R2 value is not 
sufficient.

• Fixed percentage gels: These gels have a nonlinear 
relationship between the mobility and the molecular weight. For 
these gels, choose the logistic or cubic spline regression 
method.

You can check how well each regression method fits the data in the standard 
curve window (for more information, see Standard Curve, on page 59). The 
linear (semilog) regression method provides a measurement that describes 

how well the standard curve fits the data R2 value. The closer the R2 value is 
to 1.0, the better the data fit the standard curve.

The molecular weight of each band is displayed in the Analysis Table in the 
Mol. Wt. column. Refer to page 68 for more information about molecular 
weight.

For information about the calculations behind the regression methods, see 
Appendix C: Regression Calculation Methods, on page 99.

Regression Method Minimum Number of Standard Bands

Linear (semilog) 2

Point-to-point (semilog) 2

Logistic 5

Cubic spline 5



Gel DocTM EZ System | Acquiring Images

40

Output Settings
Image Lab software prints to the default printer, unless you select otherwise.

You have three choices for specifying output:
• You can automatically print the image; this is useful for gel 

documentation, especially if a thermal printer is connected. See 
Appendix E: Mitsubishi P93/P95 Thermal Printer Settings, on 
page 103 for instructions on setting up the Mitsubishi P93/P95D 
thermal printer.

• You can automatically print the report, including all accompanying 
analysis information.

Note: You cannot print a report on a thermal printer. 
• You can display the image on your computer.

STEP 4. SPECIFY OUTPUT

11. Select Specify Output in the left pane of the Protocol Setup dialog box 
to display output options.

12. In the right pane, you can choose whether to automatically display or 
print an image or a report after a protocol runs. 

The report can be customized with the options in Edit > Report 
Settings. 

For more information about reporting options, see Generating Reports, on 
page 81.
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Review Protocol Settings

PROTOCOL SUMMARY

13. Click Protocol Summary in the left pane of any Protocol Setup dialog 
box to see a quick review of all protocol settings.

14. Click Save in the left pane to save the default protocol.
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Running a Default Protocol
To run a default protocol:

1. Place a gel on the appropriate sample tray and insert the tray into the 
imager until the magnet grabs the tray.

2. Close the door.

3. Press the green Run button on the front of the imager. The default 
protocol runs automatically.

The default protocol appears with a green background. After the 
protocol runs, the resulting image pops up and the protocol dialog box 
remains open behind it. The application name appears in the status bar 
below the gel preview window.
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Setting Up a Custom Protocol
Creating a custom protocol is similar to creating a default protocol. 

To create a custom protocol:
1. Choose New in the Protocols box on the Start Page or click New 

Protocol in the toolbar. The Protocol Setup dialog box appears.

2. Select an application from the Application drop-down menus. 

The menus list all predefined applications you can run on the Gel Doc 
EZ imager. 

Note: If you want to image a gel using a detection reagent not 
listed in the menus and do not find an equivalent reagent in the 
menus, contact Bio-Rad Technical Support for protocol 
recommendations.

Choose Custom to run an existing application with a new name or when 
you have an application unlike any existing applications. Selecting 
Custom > Manage Custom Applications from the Application menu 
displays the Manage Custom Applications dialog box. Custom 
applications you save are listed in this dialog box. An Edit button 
enables you to make changes to your custom applications.
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Note: You cannot create custom applications for the stain-free 
tray.

3. To create a custom application, click New. The Create Custom 
Applications dialog box appears.

4. Enter a unique application name.

5. The remainder of the setup instructions are the same for both default 
and custom profiles. Go to step 4, Set the image exposure in Setting 
Up a Default Protocol on page 34 and follow the instructions there. 
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Selecting a Custom Protocol
Use the same protocol repeatedly by clicking the Open button in the 
Protocols box on the Start Page or by clicking Open in the toolbar. You can 
also select recently used protocols or image files from the lists on the Start 
Page.

Running a Custom Protocol
To run a custom protocol:

1. Open a protocol or create a new one. 

2. Place your gel on the appropriate sample tray and insert the tray into 
the imager until the magnet grabs the tray.

3. Close the door.

4. Click the green Run Protocol button in the left pane of the Protocol 
Setup dialog box. The custom protocol runs automatically. 

After the protocol runs, the resulting image pops up and the Protocol 
dialog box remains open behind it. The application name appears at the 
bottom of the gel preview window.
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Editing Protocols
Protocols can be changed or renamed using the many tools in Image Lab 
software.

Open any saved protocol by choosing File > Open or by clicking Open in the 
Protocols box on the Start Page. You will be presented with the same set of 
dialog boxes and choices described in the section, Setting Up a Custom 
Protocol, on page 43. 

Make and save your changes without renaming the protocol to replace an 
older one. Save the edited protocol with a different name to make a second 
protocol.
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5 Viewing Images
Once a gel has been imaged, the image appears in the workspace. There are 
many controls to optimize viewing and to analyze your image. 

Results Overview

This is a gel image with band and lane detection and annotations. The labels 
identify overlays you can show or hide. Refer to Display Gel Options, on 
page 48 for complete information.
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There are many ways to view the data associated with your results. You can 
view your data as an analysis table, a lane profile, a standard curve and as a 
report. See Displaying Data, on page 54.

Displaying Gel Images
Display toolbar icons appear above the gel image shown on page 47. Each 
tool is described in the following section.

Display Gel Options 

ANNOTATIONS

You can choose whether or not to show text and arrow annotations that have 
been drawn on the image.

LANES AND BANDS

You can turn on or off any image overlays such as lane frames, lanes, bands, 
lane labels, and molecular weight legends.
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BAND ATTRIBUTES

You can show the following attributes for selected lanes or for all lanes. 
• Band number
• Band label
• Molecular weight
• Relative front
• Volume
• Absolute Quantity
• Relative Quantity
• Band %
• Lane %

VOLUMES

If you have drawn volume boundaries on your gel, you can display the volume 
boundaries and their volume labels.

Zoom Tools 
The zoom tools resize your gel image. Click the magnifying glass with the plus 
symbol to make your image larger; click the minus symbol to make your 
image smaller.

You can also zoom with the right mouse button. Right-click and drag to select 
an area you want to magnify. Right-click again to return to the original view.

You can also resize your image with the scroll wheel on your mouse if your 
mouse has one. 

Fit in Window 
If you are currently zoomed in on an area of your image, clicking this button 
brings your entire image into view.
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Image Transform 

Use the Image Transform dialog box to adjust image brightness and contrast 
to optimize the image display so faint detail can be seen. The minimum to 
maximum range will vary according to the light and dark values present in 
your image. 

Note: These adjustments do not change the data, only the way 
the data are displayed. The human eye cannot see the full range 
contained in the image.

The frequency distribution histogram shows the total data range in the image 
and the amount of data at each point in the range. 

The Auto Scale button automatically determines an optimal setting for your 
particular image . The lightest part of the image is set to the minimum 
intensity, and the darkest is set to the maximum. 

• The High progress indicator determines which intensity value is 
shown at the maximum gray scale (or other color) in your gel image 

• The Low progress indicator determines which intensity value is 
shown at the minimum gray scale (or other color) in your gel image

• The Gamma progress indicator changes the grayscale curve. A 
value of 1 is linear. A value < 1 redistributes a greater proportion of 
the gray scale to the first half of the intensity values. A value > 1 
redistributes a greater proportion of the gray scale to the second 
half of the intensity values.

You can also type numerical values into the text boxes next to the progress 
indicators. Clicking anywhere on the progress indicator bars moves the 
progress indicator incrementally.
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Options:
• Invert image display—Inverts dark bands on a light background to 

light bands on a dark background and vice versa
• Highlight saturated pixels—When this checkbox is selected, 

areas of the image with saturated (above a measurable range) 
signal intensity are highlighted in red

• Linear or Logarithmic histogram—This adjustment changes the 
Y axis on the histogram to display how many pixels are at each 
intensity value

Image Colors 

 

This dialog box enables you to choose a colormap for your image results file. 
Viewing the image with a different color scheme can make it easier to see all 
the elements in the image but does not change your data.

You have many color choices. The first eight choices imitate the colors of 
stained gels. The remaining choices supply enough color variation to highlight 
small differences in the image data.

Available colors include:
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3-D Projection 

Clicking the 3-D icon transforms your gel image into a solid three-dimensional 
model spinning in space with x, y, and z dimensions. Accentuate or diminish 
the relative heights of data points by pulling the progress indicator at the 
bottom of the window to the right or left.

To open the viewer: 
• Select the 3-D icon from the toolbar above the image.

To view the intensity of various bands:
1. Drag the model to rotate it to your preferred view. 

2. Bring the window into focus by clicking the image. 

3. Press C to display a green cone, which can be dragged around to 
evaluate the intensity of various bands.

• Gray • Flamingo™ fluorescent gel stain

• EtBr (Ethidium bromide) • Silver

• Coomassie • False color

• Stain-free • Spectrum

• SYBR® Green • Gold-Silver

• SYPRO Ruby • Pseudo
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Image Info 
The Image Info dialog box provides information about the active image. Click 
the icon on the image toolbar to display three tabs of information about your 
image. 

IMAGE DETAILS

Acquisition and image information appears on this tab.

ANALYSIS SETTINGS

This tab displays the settings that were used when the gel was analyzed (for 
example, Band Detection and Molecular Weight Analysis, if they were 
performed).

NOTES

On this tab you can add notes, make custom labels for each of the lanes, 
point out the type of samples used, or indicate other details about the results.
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Displaying Data
The results from analyzed data associated with gel images can be visualized 
using an Analysis Table, a Lane Profile, a Standard Curve, or as a Report.

The report cannot be viewed with the lane profile and standard curve. The 
report replaces these windows. Lane profiles can be seen in the report 
window.

Buttons to toggle these views on and off are located in the main toolbar. Each 
option is described as follows.

Lane and Band Definitions
• Band Number—Each band in a lane has a unique number, sorted 

from top to bottom
• Band Label—Users can assign a custom label to each band by 

clicking in the Band Label field of the Lane and Band table 
• Molecular Weight—The molecular weight of the band is 

calculated based on the user-defined standard and regression 
method. Italic values indicate extrapolated values

• Relative Front—Values between 0 and 1 indicate the relative 
movement of the band from top to bottom

• Abs. Quant.—Absolute quantitation of the band
• Rel. Quant.—Relative quantitation of the band compared to the 

reference band
• Band %—Percentage of the band volume compared to all band 

volumes in the lane
• Lane %—Percentage of the band volume compared to the entire 

volume of the lane

Volume Definitions
• Volume Number—Each volume has a unique number 
• Volume Label—Software-generated labels for different types of 

volumes (U-unknown, B-background, S-standard) can be changed 
by the user in Volume Properties

• Volume—The sum of all the intensities within the band boundaries
• Adjusted Volume—The background-adjusted volume
• Mean Background—The mean value of the background 
• Absolute Quantity Volume—The quantity of the volume based on 

the standard volumes and the regression method
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• Relative Quantity Volume—The ratio of the adjusted volume and 
the adjusted volume of the reference volume

• # Pixels—Number of pixels inside the volume boundary
• Minimum Value—Intensity of the pixel with the minimal intensity 

inside the volume
• Maximum Value—Intensity of the pixel with the maximum intensity 

inside the volume
• Mean Value—Mean value of all pixels inside the volume boundary
• Standard Deviation—Standard deviation of all pixels inside the 

volume boundary

• Area—Area of the volume in mm2

Analysis Table Options 
Numerical data associated with your analysis can be viewed in the Analysis 
Table. Data from the Lane and Band analysis can be viewed in the Lane and 
Band tab. If volume analysis was performed, these data can be viewed on the 
Volume Table tab. 

Clicking the Analysis Table button opens a tabular display of the data 
extracted from the results. 

Icons above the table offer several ways to display and export Analysis Table 
data. 

SET WINDOW SIZE

To change the size of the Analysis Table window, drag the edge of the window 
until all of the data are visible.

Note: Resizing the Analysis Table window is restricted when a 
Protocol dialog box is open. 
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DISPLAY DATA OPTIONS 
This dialog box features three tabs: Measurements, Display, and Export.

Measurements—Choose the measurements you want to display by clicking 
the arrow buttons to move items from the Displayed to the Not Displayed 
field.

Default Display Settings—The setting, Move selected lane to top, is on or off 
depending on whether the checkbox is selected or not.

Per Measurement Precision—You can set the precision (decimal places) for 
the measurements in both the Lane and Band table and the Volume table.

Example Precision—This field shows how your measurement will display 
with the number of decimal places you choose in Per Measurement Precision.

Export Formatting—This field offers two checkboxes to include lane headers 
(Lane and Band table tab only) and/or column headers in your exported file.

Export Delimiter—This field offers three delimiter options for the exported 
file. 

• Comma-delimited comma-separated values (CSV)
• Tab delimited
• Other user-defined delimiter 

CHANGE ANALYSIS TABLE ORIENTATION 
This button toggles between two table orientations.

Horizontal—Displays the lanes/volumes beside each other so the user can 
scroll through the table from left to right.

Vertical—Displays the lanes/volumes on top of each other so the user can 
scroll through the table from top to bottom.

EXPORT AN ANALYSIS TABLE

The next three buttons offer several ways of exporting the data in the Analysis 
Table. See Chapter 8, Exporting Results, on page 85 for more information 
about exporting your data.

Copy Analysis Table to the Clipboard—Click this button to copy the 
Analysis Table to your clipboard so you can paste your Analysis Table 
into a word processing program or presentation application. It is best to 
use the Vertical table orientation when copying to an 8-1/2 x 11-inch page to 
allow enough room to display the columns.

Export Analysis Table to a File—When exported as a CSV file, the 
data file can be opened in a database application.
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Export Analysis Table to a Spreadsheet—This function enables you 
to use Excel’s sorting and formula functions to manipulate your data. If 
you have this program installed on your computer, Excel (or Numbers, 
on a Mac) opens with your spreadsheet displayed.

Lane Profile 

The Lane Profile option shows a cross-section of the selected lane rotated 
90°. You can select other lanes by clicking them while the Lane Profile window 
is open.

If the Include Background checkbox is selected, the Lane Profile window 
shows the subtracted background under the blue line and the area used for 
band quantification in green under the red line.

See the current Rf (relative front) value and the intensity at the cursor in the 
lower right corner of the Lane Profile screen.

Change how the bands are labeled by choosing from the options in the drop-
down list. By default, the bands are labeled with the band number. 

SCALE TO FIT GRAPH 
Choose the highest point of the display to define the range of the graph to 
provide the best view of the lane profile. 

You can clear the Scale to Fit Graph checkbox to display the entire range of 
possible intensity values in your graph. This allows valid comparisons among 
different lanes.
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INCLUDE BACKGROUND

If you clear the Include Background checkbox, the area of the Lane Profile 
that represents the background of the image is not displayed.

IDENTIFY BANDS BY

You can display callouts on the Lane Profile that indicate these attributes:
• Band number
• Band label
• Molecular weight
• Relative front
• Volume
• Absolute Quantity
• Relative Quantity
• Band %
• Lane %
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Standard Curve 

The Standard Curve dialog box displays the best curve fit for your defined 
standards and the bands relative to this curve for the lane you select in the 
image. The tabs display the standard curves for three different analyses.

Standards appear in green, and unknown bands are red. You can change the 
molecular weight display on the Y-axis between linear and log scale by 
clicking the Log Y-axis box at the upper left. The regression method you 
chose in Molecular Weight Analysis Tools displays, as does the formula (if 
applicable) and the R2 value of the regression method. 

Tabs in this window enable you to view the Molecular Weight Standard Curve, 
the Absolute Quantity Standard Curve, or a Volume Standard Curve.

Report 
See Chapter 7, Generating Reports, on page 81, to find out what you can 
include in a report. 
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6 Analyzing Images
The Analysis Tool Box tools are enabled once an image file is opened and in 
focus. An active or in focus window has a darker blue menu bar on a Windows 
PC. On a Mac, the window control icons display in brighter color when a 
window is active. This distinction helps you to identify the active window 
among many open image files in your workspace.

Auto Analysis Settings

Clicking the Auto Analysis  button in the Analysis Tool Box 
enables you to do the following:

• Analyze images that were obtained with protocols that did not 
include steps for detection and analysis

• Change your analysis parameters to reanalyze your images 

Note: When you change any settings for an analyzed gel, the 
initial analysis is overwritten. To preserve both analyses, save 
your image file under a different name.
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Detection Settings

Band detection options are as follows:

Low Band Detection Sensitivity—This option sets detection at a low level for 
images with prominent bands. Faint bands are not detected with this setting.

High Band Detection Sensitivity—This option sets detection at a higher level 
for images that are faint. Extraneous bands can be removed using the Band 
Tools in the Analysis Tool Box. See Lane and Band Tools, on page 65.

Custom—You can set a numerical value between 1 and 100 to select the best 
detection sensitivity for your sample.

NOTE: When Low or High Band Detection Sensitivity is used, the following 
numerical values are set: low sensitivity = 25; high sensitivity = 75.

Molecular Weight Analysis Settings
Molecular Weight Standard—Run any of the many Bio-Rad standards or 
otherstandards that you have placed in your standards list. For more 
information, refer to Standards, on page 38. 

Standard Lanes—Choose or change the lanes in which the standards are 
placed. 

Regression Method—Four regression methods are available. For more 
information,  see “Regression Methods” on page 39.
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Analysis Toolbox Tools
All Analysis Toolbox tools customize the analyzed data in your image files. 
These tools are available only when an image file is open. Click a specific 
image to select among many windows that may be open in your workspace. 
On a PC, the menu bar of the selected window becomes a darker blue than 
other windows. On a Mac, the window control icons display in brighter color 
when a window is active.

Note: Some tools delete the existing analysis. 

To access a tool:
• Click any of the Tool Box icons 

To return to the Analysis Tool Box menu:
• Click the green up-arrow button to the right of the tool name

Image Tools 
To show the image view menu, click the Image Tools button.
 

FLIP 
You can flip your gel image horizontally or vertically.

ROTATE
You can rotate your gel image 90° using the Left or Right buttons. 

To correct a slanted gel: 

Click the Custom button and do the following:

Click to return
to the Analysis
Toolbox menu
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• Rotate the red arrows that appear over the gel to any degree 
between 0 and 360° by clicking and dragging them.

• Right-click on the gel image and choose Rotate to set your gel in 
the new position. You will be prompted to Cancel or Continue in 
case you want to reset the rotation.

CROP

To retain only a portion of the gel image:
1. Click the Crop button.

2. Using the square handles, drag the red box to include the area you 
want to keep. 

3. Right-click within the red box to remove the rest of the image. You will 
be prompted to Cancel or Continue in case you want to reset the area. 

INVERT DATA

Invert Data is used for negative stains and zymograms. Intensity values of 
bands must be greater than background to perform analysis on the gel. View 
your gel as a 3-D projection to determine if the data must be inverted.

MERGE
(ChemiDoc™ XRS+ system only.) Use this button to merge a 
chemiluminescent blot image with a colorimetric image of the same blot. If 
you have used colorimetric prestained standards for your chemiluminescent 
blot, you can acquire an epi-white light image of the blot to show the 
standards and a chemiluminescent image to show your immunodetection. 
These two images can then be merged into a combined image with both 
signals. 

Note: Merging images can have an adverse effect on 
quantitation. If accurate quantitation is required, perform analysis 
on the original separate images. Only images of the same size 
can be merged.
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Lane and Band Tools
Click the Lane and Band Tools button to select a tab to use the 
lane tools and band tools.

LANE TAB

You can choose how your lanes are detected using the Automatic or Manual 
Lane Finder buttons.

• Click the Automatic button if your gel image is typical
• Click the Manual button to detect only a specific number of lanes 

or if automatic lane detection did not find the correct number of 
lanes. You can then drag the handles on the corners of the red 
square to resize the lane frame 

ALL LANES

Resize—You can resize all of the lanes by dragging the handles on the 
corners of the red square to fit your gel image.

Adjust—If your gel image is irregular, you can adjust the orientation of all 
lanes by dragging a single corner of the lane frame. Using the adjust lanes tool 
will not change the lane widths.
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You can also add more anchor points on the top or bottom borders of the 
rectangle by clicking the lane frame. Remove any unneeded anchor point by 
right-clicking it. By dragging these anchor points, you can adjust for so-called 
smiling gels.

Delete—You can delete all lanes.

SINGLE LANE

Add—You can add a single lane to your gel image. First click the Add button, 
then click within the lane frame where you want to place the new lane. The 
lanes are renumbered.

Note: To add a lane outside the frame, add a lane inside the 
frame and use the Move tool to expand the lane out of the 
frame’s boundaries.

Delete—You can delete a single lane. First click the Delete button and then 
click on either the lane or its lane number. The lanes are renumbered.

Bend—You can bend a single lane to better fit your gel image. First click the 
Bend button and then drag one of the square anchors to fit your image.

You can add more anchor points within the lane by left-clicking it. Drag these 
anchor points to adjust the lane to fit the gel image. Remove anchor points by 
right-clicking them.

Move—You can move a single lane to a new position on your gel image. First 
click the Move button, then click the lane you want to move. Drag it to a new 
location. The lanes are renumbered according to their new position.

Width—You can change the width of a single lane.

LANE BACKGROUND SUBTRACTION

Perform lane-based background subtraction by selecting Enable Subtraction 
in the Background Subtraction field. Use the Lane Profile view to see the 
subtracted lane background.

Rolling Disk—You can specify the size of a hypothetical rolling disk (between 
1 and 99 mm) that removes background levels along the length of the lane. 
The size of the disk determines how much background is subtracted. 

A large disk follows the profile trace less closely, touching fewer points along 
the trace and removing less background. A smaller disk more closely follows 
the profile trace, removing more background.

A disk radius that is too large results in poor background removal. A disk 
radius that is too small may subtract actual data. For most samples, a size of 
< 10 mm is usually appropriate. You can perform this task several times until 
you are satisfied with the amount of background removed.
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Apply to Selected Lane—If you select this box, the level of background 
subtraction specified with the previously described buttons is applied only to 
the selected lane. This option gives you the opportunity to set different 
background subtraction levels for each lane.

BANDS TAB

This tab enables you to detect bands or reset band detection settings. Click a 
button in the menu, and then click in a lane of your image.

Add—Use this option to add faint bands. First click the Add button, and then 
add a new band by clicking anywhere inside that lane. 

Note: You can darken your entire image to view faint bands more 
easily using the Gamma slider in the Image Transform dialog box. 
For complete instructions, see “Image Transform” on page 50.

Delete—You can delete bands that are not relevant to your analysis. First click 
the Delete button, and then click any bands you want to remove.

Adjust—You can adjust the height of a band. First click the Adjust button. Two 
boundary lines appear around each band. Move over a boundary line until you 
see a double-headed arrow. Move the boundary line up or down and the 
center recalculates; the band appears there.

Note: You can also adjust the band boundaries in the Lane Profile 
view.
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Molecular Weight Analysis Tools
Molecular Weight Analysis tools enable you to determine molecular 
weight by comparing your test sample with known standards.

Note: You can view each band’s molecular weight in the 
molecular weight column of the Lane and Band tab, in the 
Analysis Table view.

MOLECULAR WEIGHT STANDARD

You can change the standards used to determine the molecular weight of your 
test samples. Click the Change button in the Molecular Analysis Tools dialog 
box to access the Manage Standards dialog box, where you can choose 
another standard or add third-party standards. 
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STANDARD LANES

Standard samples are placed in the first and last lanes by default. You can 
specify other standard lanes by selecting the box below each lane or by 
entering the standard lane numbers separated by commas. The Standard 
lanes are labeled Std below the lane. 

REGRESSION METHODS

There are four regression methods. See Regression Methods, on page 39.

Quantity Tools 
You can quantitate bands in your test samples automatically by 
using the relative or absolute tabs under Quantity Tools.

RELATIVE QUANTITY TAB

To compare the relative quantities of bands, select the Quantity Tools Relative 
tab, as shown.

To select a reference band from your image and quantitate all other 
bands relative to the reference band:

1. Click the Select button.
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2. Click any band you want to use as a reference. A small “R” for 
Reference appears near the band you selected (see the red circle inside 
of the image on the left). 

To review the relative band quantities: 
• Go to the Rel. Quant. column of the Analysis table, Lane and Band 

tab. The relative quantity is the ratio of the band volume divided by 
the reference band volume.

All the other bands now display numerical values that are relative to your 
reference band. Values above 1.0 indicate that the band quantity is greater 
than that of the reference band. Values below 1.0 indicate the band quantity is 
less than that of the reference band.
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ABSOLUTE QUANTITY TAB

Absolute quantification is used to quantify bands based on known standard 
bands using a calibration curve. To determine the absolute quantities of 
bands, first select the Quantity Tools Absolute tab, as shown.

To calculate the absolute quantities of the bands:
1. Click the Select button.

2. Select at least two standard (known) bands and assign quantity values. 
The values display in the Standard bands table. The greater the number 
of known bands and the wider the range of their values, the more 
accurate is the absolute quantity calculation of the unknown bands.

Note: Any standard bands selections can be deleted. To do so, 
select the entry in the Standard Bands field by clicking it and then 
clicking the Delete button.

3. Select a unit of measure from the ten choices listed in the Units drop-
down menu. 
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4. Select a regression method from the three listed in the drop-down 
menu. Keep the following guidelines in mind while making your choice.
Linear—This regression method generates a straight line that is the 
best fit of the values you provided and is preferred in most cases. 
Point-to-Point—This method generates a curve in which each data 
point is connected directly to the next, regardless of the shape of the 
resulting curve.
Cubic spline—This method generates a smooth curve that connects 
each data point. At least four standard points are required to use this 
method of least-squares polynomial fits.

5. Click the Standard Curve button in the toolbar, select the Abs. Quantity 
Standard Curve tab, and a calibration curve displays. All standards are 
represented by green triangles. Unknown values are represented by red 
triangles.

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

Note: Clicking any triangle in your Standard Curve table displays 
the numerical values associated with that band.

Regression Method
Minimum Number of 

Standard Bands

Minimum Number with 
Force Through Origin 

Option

Linear 2 1

Point-to-point 2 1

Cubic spline 5 4
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Annotation Tools
You can annotate your results with text and arrows to draw 
attention to areas of interest.

ADD ANNOTATIONS

Text—You can add text annotations to your gel images to point out important 
details. First click the Text button, then click an area you want to emphasize. A 
text box appears with a dotted-line border. Type your comment in the text 
box. Drag the box to change its position.

Note: While editing text, press SHIFT-ENTER to add text. This 
adds a new line in the annotation.

Arrow—To add an arrow, first click the Arrow button. Click the area where you 
want the arrow to start and then drag to stretch the arrow point to the location 
you want to emphasize. To move the arrow, click the middle and drag it. To 
change where the arrow points, click either end of the arrow. Square boxes 
appear; drag a box to change the length or orientation of the arrow.
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ALIGNMENT

Alignment Icons—These icons enable you to align multiple annotations such 
as lane numbers that you have added manually.

To select annotations—You can select several annotations by holding down 
the CTRL key (Command key on the Mac) and clicking each one or by 
dragging a selection box around them.

To copy annotations—You can copy annotations within or between images. 
First select the annotation you want to copy. Then press CTRL-C (Command-
C on the Mac) to copy and CTRL-V (Command-V on the Mac) to paste the 
annotations.

TEXT PROPERTIES

You can change the size and type font of your text annotations. To select 
multiple items for change, hold down the CTRL key (Command key on the 
Mac) and click each item.

Font—First click the text box you want to change. Then click the drop-down 
Font menu to show all fonts installed in your system. Select one of the font 
names to change the style of your text annotation.

Size—First click the text box you want to resize. Click the up and down Size 
arrows to increase or decrease the size of your text. You can set the font size 
between 6 and 72 points using the drop-down menu. 

COLOR

You can change the color of your text annotations to make them visible with 
any color scheme and emphasize them further by adding a color to the 
annotation’s background, which is invisible by default. 

To change the color of multiple items, hold down the CTRL key (Command 
key on the Mac) and click each item.

Foreground—Click a text annotation or arrow. This enables the Foreground 
field, so you can use the drop-down menu to choose a different color.

Background—Click a text annotation. This also enables the Background 
field, so you can use the drop-down menu to choose a background color.

ROTATE

You can rotate your text annotations 90° to the left or right by clicking the 
Rotate buttons.
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Volume Tools
Volume tools enable you to manually quantitate features on your 
sample image when automated lane and band analysis is not 
appropriate or possible, such as in dot blots. 

You can use Volume Tools to quantitate the signal intensity of bands, spots, 
arrays, and other image data. You can define an area of interest by 
surrounding it with a shape. You can choose a rectangle, circle, or freehand 
shape by clicking the buttons under the Volumes field. 
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A default label appears within the shape drawn. The volume label can be one 
of three types–U for unknown, Std for standard, or bfor Background—along 
with a number that is assigned sequentially.

Each new volume you create initially has a red border, which indicates that the 
volume is selected. If you click elsewhere on the image, the border changes to 
blue, indicating that the volume is deselected.

Note: Double-click a volume area to change its properties. You 
can define the volume type (unknown, standard, or background) 
and its quantity or enter a custom name to replace the default 
label.

 

p
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RELATIVE VOLUME QUANTITY

You can choose any one volume as a Reference Volume by selecting the 
Reference Volume checkbox in the Volume Properties dialog box. The 
Reference Volume is indicated by an asterisk on the volume label, for 
example, U1*.

Relative quantities are displayed in the Relative Quantity column in the Volume 
Table. The relative quantity is the ratio of the background-adjusted volume 
divided by the background-adjusted reference volume.

All the other volumes now display numerical values relative to your reference 
volume. Values above 1.0 indicate that the volume is greater than the 
reference volume. Values below 1.0 indicate the volume is less than the 
reference volume.

When you click the Standard Curve icon in the toolbar, a chart displays all of 
the unknown and standard quantities.

ALIGNMENT

Align volumes by using the appropriate alignment icon. To select several 
volumes, CTRL-click each one or drag them to use a selection box.

Copy and paste selected volumes by pressing CTRL-C to copy and CTRL-V 
to paste (Command-C and Command-V on the Mac). 

VOLUME BACKGROUND SUBTRACTION

When you draw a volume, some nondata background pixels may be included 
inside the volume. These background pixels usually will have an intensity 
value that you do not want to include in your volume quantitation. There are 
two ways of calculating this background intensity for your volumes: local and 
global.

Local—Local background subtraction calculates a separate background 
intensity for each unknown and standard volume you create. For each volume, 
the intensities of the pixels in a 1-pixel border around the volume are added 
together and divided by the total number of border pixels. This gives an 
average intensity for the background around each, which is then subtracted 
from the intensity of each pixel inside the volume. If the background value is 
greater than the pixel value inside the volume, the background-adjusted 
quantity of the volume may be < 0. In this case, you should redraw the border 
for this volume.

Global—Global background subtraction calculates a single background 
intensity for the entire gel. This average background intensity is then 
subtracted from all volumes in the gel. 
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To calculate global background subtraction:
1. Create a volume using one of the volume tools in a representative 

background region of your image (that is, a nondata region similar to the 
background surrounding your data).

2. Double-click the volume. This opens the Volume Properties dialog box. 
Select the Background option button. The average intensity of the 
pixels in that background volume will be calculated and subtracted 
from each pixel in all standard and unknown volumes. Therefore, it is 
not necessary for the background volume area to be the same size as 
your unknown.

Notes:
• If you select Global in the Volume toolbox but do not define a 

background volume as described, no background subtraction will 
be performed 

• If you create more than one background volume, all the pixels in 
those background volumes will be used to calculate the average 
background. Your background volumes will have default names B1, 
B2 . . . etc., based on the sequence in which they were created

• If the region you defined as background has a higher average 
intensity value than your data object, you will obtain a negative 
value for your adjusted volume in the Analysis Table. If this 
happens, select a new background region with less intensity than 
your data object

VOLUME STANDARDS

If you have drawn your volume around an object of known quantity, you can 
use it to calculate the quantity of your unknown volumes. 

1. To classify a particular volume as a standard, double-click it. This opens 
the Volume Properties dialog box.

2. Select the Standard option button, then enter the quantity in the 
quantity field. Click OK to close the dialog box. Your standard volumes 
will have the default names S1, S2, and so on, based on the sequence 
of their creation. The quantities of your unknown volumes are calculated 
based on the standard volumes and the selected regression method.
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To review the regression curve, open the Standard Curve window and select 
the Volume Standard Curve tab.

REGRESSION METHODS

Three regression methods are available to generate the volume quantitation 
curve: linear, point-to-point, and cubic spline. To display the standard curve, 
click the standard curve icon in the tool bar and select the volume standard 
curve tab. See Appendix C: Regression Calculation Methods, on page 99 for 
information on how each of these methods is calculated.

The data for volume standards are found in the Absolute Quantity column of 
the Volume Table. 

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.
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7 Generating Reports
After viewing your results, you can generate a report that displays the 
analyzed gel images, all of the protocol settings, and as much information 
about your data as you want to include.

The print report settings can be chosen with the Report Settings dialog box in 
the Edit menu or from the Report button in the main toolbar. 

Click the Report  icon to produce a Print Preview of your report.

Clicking the Print icon  prints all the previewed information to a printer.
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Removing Information from Reports
Use the following option screens to remove information from your reports. 
This will not not delete data from your analysis; it will simply omit information 
from the report.

DISPLAY REPORT GENERAL TAB 
By default all information is included. You can customize your reports to 
include just the information you want.

Clear a checkbox to remove a report item.

Custom Report Title—You can provide a custom report title for your report.

Include Gel Image—The following options control which overlays display on 
your gel image:

• Show Lanes and Bands
• Show Volumes
• Show Annotations
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Image Info:
• Acquisition Information
• Analysis Settings
• Image Information
• Notes

LANE AND BAND TABLE TAB

If no lane and band analysis has been done, the options in this tab appear 
dimmed.

Clear any of the boxes to exclude the information from your report.

Include Lane and Band Table

Lanes to show: 
• All lanes with continuous display or just user-defined lanes
• All lanes or one lane per page (add page break after each lane)

Show Lane Profile—Includes the lane profile for each lane.

Move labels to the left if you do not want to include their columns in the 
report.
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VOLUME TABLE TAB

If no volume analysis has been done, the options in this tab appear dimmed.

Include Volume Table—Clear the checkbox if you do not want this 
information in your report.

Move volume labels to the left if you do not want their columns to be 
included in the report.

Printing a Report
You can automatically print a report when you run a protocol. See Output 
Settings, on page 40 for more information.

To print a report:
1. Click the Print Report icon. 

2. Click Print in the Image Print Preview toolbar.

To print a report to a .pdf file:
1. Click the Print Report icon. 

2. Click Print Report to PDF in the Image Print Preview toolbar to save the 
report to a .pdf file on your computer
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8 Exporting Results
The most convenient way to archive complete information about your 
experiments is to produce reports. But you may want to export only gel 
images or analysis table data for analysis in different programs such as 

Quantity One, FPQuest™, or InfoQuest™FP. Or, you may need exported files 
for presentation or publication. 

Exporting Gel Images
Image Lab software includes features for exporting gel images several ways. 

• You can export displayed image data to a publication (choose 
Export for Publication) 

• You can export raw image data as a 16-bit TIFF file (choose Export 
for Analysis) 

• You can export image data to PulseNet; doing so reduces the 
image to an 8-bit TIFF file, limits its resolution, and restricts its file 
size to 300 Kb

• You can export lane and band tables as well as volume tables to a 
spreadsheet program or to a file 

The options to export gel images are available from the Export option in the 
File Menu.
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The available export options are described in the following sections.

Exporting Gel Images for Publication
Use this format only to export visual information to presentation or word 
processing software, such as PowerPoint or Word.

When you select File > Export > Export for Publication, you can export a 
displayed image to a file. You can select from .bmp, .png, .jpg, and TIFF 
formats. The gel displays with any lanes, bands, and annotations that appear 
on the screen.
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Note that you can select the entire image or the current view, select the 
resolution or specify a custom resolution, specify the publishing dimensions, 
and view the resulting published image size and dimensions. 

You can zoom in on an area in a current view to export only that area or you 
can export the entire image. You can exclude annotations or overlays by 

clicking the Display Gel Options  icon in the toolbar to access the 
appropriate settings.

Exporting Gel Images for Analysis
When you select File > Export > Export for Analysis, you can export full image 
data (raw data only) for analysis as a 16-bit TIFF file. The image may require 
contrast adjustment when it is imported into analysis software. This option 
creates a file that can be analyzed in other software such as Quantity One, 
FPQuest, or InfoQuestFP. 

Note: Sixteen-bit TIFF images are not compatible with all image 
viewers.

Exporting Gel Images to PulseNet
When you select File > Export > Export for PulseNet, Image Lab reduces the 
image to an 8-bit TIFF image file. Resolution is limited and file size is restricted 
to 300 Kb. 
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Exporting Lane and Band Tables to Excel
If you have Excel (or Numbers, on a Mac) installed on your computer, 
choosing File > Export > Lane and Band Table to Excel opens a table directly 
in Excel. You can then use the Save As option to produce other formats.

Exporting Lane and Band Tables to File
Choosing File > Export > Lane and Band Table to File exports as a separated 
CSV file so the data file can be opened in a database application. 

Exporting Volume Tables to Excel
If Excel is installed on your computer (or Numbers on a Mac), choosing File > 
Export > Lane and Band Table to Excel opens a table directly in Excel. You 
can then use the Save As option to produce other formats.

Exporting Volume Tables to File
Choosing Export > Volume Table to File exports as a CSV file so the data file 
can be opened in a database application. 

Snapshot Tool Export 
Use the Snapshot tool, available in the toolbar, to capture a displayed image 
to the clipboard or to save it to a file (.bmp, .gif, or .png). 

Analysis Table Export
You can export table analysis data from the File menu or by using the export 
buttons at the top of the Analysis Table window. 

The Analysis Table window has several buttons to export data to different 
formats, depending on how the data are to be presented.

COPY ANALYSIS TABLE TO THE CLIPBOARD 
Click this button to copy the analysis table to the clipboard and to paste your 
analysis table into spreadsheet, word processing, or presentation 
applications. It is best to use the vertical table orientation when copying to an 
8-1/2x11-inch page to allow enough room to display the columns.
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EXPORT ANALYSIS TABLE TO A FILE 
This button exports your analysis table as a CSV file so your data file can be 
opened in a database application.

EXPORT ANALYSIS TABLE TO A SPREADSHEET 
This button enables you to use Excel’s sort and formula functions with your 
data. If you have Excel (or Numbers, on a Mac) installed on your computer, 
your data open in Excel.
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Appendix A: 
Maintenance and 
Specifications

Cleaning the Sample Trays
Clean the sample trays with standard laboratory detergents or mild solvents 
such as EtOH or MeOH. Use lint-free tissue to wipe them dry. Dust particles or 
lint on a sample tray can glow under UV illumination.

UV-B Fluorescent Lamp Replacement
The UV-B lamps provide service under normal usage for 4–5 years. In case of 
a lamp failure, one of the following error messages appears:

• Fault in UV bulbs Bank 1&2 
• Fault in UV bulbs Bank 1 
• Fault in UV bulbs Bank 2

To replace the lamps:
1. Turn off the instrument and unplug the AC cord. 

2. Remove and save the seven screws around the outside edge of the 
imager back. Do not remove the screw at the bottom left outside corner 
of the imager back.
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3. Carefully slide the top cover toward the back of the instrument until it is 
all the way off. 

4. On the left side of the instrument a single screw holds the lamp 
assembly in place. Remove and save this screw. 

5. Carefully slide out the lamp assembly. Although only one lamp bulb may 
be out, it is recommended that all lamps be replaced to ensure even 
illumination and to reduce the need to access the lamps again.

6. Replace all lamps with UV-B fluorescent lamps (Bio-Rad part number 
900-0217). Make sure each lamp is properly seated in its holder.

7. After replacing all the lamps, carefully slide the lamp assembly back into 
the instrument. Press on the side of the lamp assembly to the right of 
the screw hold down tab, to make sure it is fully seated into the 
instrument. If the lamp assembly is not fully seated, the following error 
message appears the next time it communicates with Image Lab 
software: Light tray not detected.
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Error Messages
Sample tray not detected 

The sample tray has a magnet that senses when the sample tray is inserted. If 
you attempt to image and this message appears, the sample tray may not be 
pushed in all the way. Press the tray in until the magnet grabs the tray.

Light tray not detected 

This error message appears if the lamp assembly is not fully seated into the 
imager. Reseat the lamp assembly as described on the previous page.

Door was opened during imaging

To prevent UV radiation exposure, the UV-B lamps do not turn on unless the 
front sample tray door is fully closed. This message also appears when the 
instrument cover has been removed.
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Technical Specifications
Hardware Specifications

Image area 15 x 11.2 cm

Excitation source Trans UV B (302 nm peak)

Detector Charge-coupled device

Image resolution 1,392 horizontal x 1,040 vertical pixels

Image Pixel Size 107.8 x 107.8 um (in microns)

Dynamic range 3.0 orders of magnitude

Pixel density 4,096 gray levels

Flat fielding Yes

Instrument size 43 x 28 x 38 cm

Instrument weight 7.3 kg

Connector descriptions USB-A connector is used for communication with a PC 
USB-B connector is used for the instrument interface

Software Specifications

Operating system 
compatibility

Windows XP SP3 or higher
Windows 7 (32- and 64-bit)

Mac OS 10.5 or 10.6

Image file size Approximately 2.5 MB

Computer interface USB 2.0

Operating Ranges

Operating voltage 110/115/230/240 VAC Nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity < 70% noncondensing

Equipment Ratings

Input voltage range 100–240 VAC 
Input frequency range 50–60 Hz.

Power 40 W

The Gel Doc EZ imager is for indoor laboratory use only.

Automation Capabilities

Workflow automated 
execution

Controlled by a protocol via setup for gel activation, image 
capture, analysis, and reporting

Workflow reproducibility 100% repeatability via recallable protocols, from gel activation 
and image capture to quantitative analysis and reports

Autoexposure 2 user-defined modes (intense or faint bands)
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Appendix B:  
Using the Criterion™ Stain 
Free™ System

The Criterion Stain Free system comprises the Gel DocTM EZ imager, Image 
Lab™ software, and three types of precast gels:

• Criterion™ TGX™ Stain-Free
• Criterion Stain Free 

• Mini-PROTEAN® TGX™ Stain-Free 

The Stain Free system eliminates the time-consuming staining and destaining 
steps required by other protein detection methods. Stain Free gels include 
unique trihalo compounds that allow rapid fluorescent detection of proteins 
with the Gel Doc EZ imager — without staining. 

The trihalo compounds in the gels react with tryptophan residues in a UV 
light–induced reaction to produce fluorescence, which can be easily detected 
by the Gel Doc EZ imager within gels or on low-fluorescence PVDF 
membranes. Activation of the trihalo compounds in the gels adds 58 Da 
moieties to available tryptophan residues and is required for protein 
visualization. Proteins that do not contain tryptophan residues cannot be 
detected using this system. The sensitivity of the Stain Free system is 
comparable to staining with Coomassie Brilliant Blue for proteins with a 
tryptophan content >1.5%; sensitivity superior to Coomassie staining is 
possible for proteins with a tryptophan content >3%.

Benefits of the Stain free system include:
• Elimination of staining and destaining steps for faster time to 

results
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• No background variability within a gel or between gels (as is often 
seen with standard Coomassie staining)

• Elimination of the need for acetic acid and methanol in staining and 
destaining, reducing organic waste

• Visualization of transferred or blotted proteins on low-fluorescence 
PVDF membranes

Stain Free Workflow
For detailed information about workflow steps, refer to the Criterion™ Precast 
Gels Instruction Manual and Application Guide or to the Mini-PROTEAN® 
Precast Gels Instruction Manual and Application Guide except where 
otherwise noted.

Electrophoresis with Stain Free Gels
Stain Free gels are made and packaged without SDS so they can be used for 
both SDS and native PAGE applications.

To perform electrophoresis with these gels, prepare the sample and running 
buffers, set up the electrophoresis cell, and perform the run.

See Chapter 4, Acquiring Images

Prepare Buffers

Prepare Gels and Assemble
Electrophoresis Cell

Prepare and Load Samples

Perform Electrophoresis

Activate/Image Gels

Analyze the Separation

 



Imaging Gels

97

Imaging Gels
Use unstained standards with Stain Free gels, as some prestained standards 
are not detected by the Stain Free system. To monitor electrophoresis, use a 
1:1 mixture of unstained and prestained standards.

Setting up a protocol for Stain Free gels is in many ways the same as setting 
up protocols for other applications. Follow the instructions in Setting Up a 
Default Protocol, on page 31 but after step 3, set the activation options for the 
gel as follows.

Set the activation options: Visualizing proteins requires activation of the gel. 

Choose an activation time option based on your 
sample and the purpose of your experiment:

• Use 2.5 min activation when samples are 
abundant and when a fully optimized signal-
to-noise ratio is not necessary

• Use 5.0 min activation for detection of proteins 
that are in low concentration and for the best 
quantification of the maximum number of 
bands. Because the reaction is near completion after 5 min, this 
method offers an optimal signal-to-noise ratio

Note: If the gel has already been activated for 2.5 min, activating 
it for another 2.5 min may improve it; but activating an image for 
more than 5 min will not.

Continue setting up the protocol at step 4, Set the image exposure, on 
page 34.

Imaging Blots
To blot Stain Free gels, use standard blotting procedures as described in the 
instruction manual you are using. Use only PDVF membranes with low 
background fluorescence, as membranes other than low-fluorescence PDVF 
can result in high background or low sensitivity with the Gel Doc EZ imager.

To assess transfer efficiency, be sure to activate and visualize the gel using the 
Gel Doc EZ imager before transfer.
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Appendix C: 
Regression Calculation 
Methods

Each regression method calculates a standard curve. Some of the methods 
provide the formula for the standard curve. In this case, the molecular weight 
can be calculated by:

x = relative front of the band of interest

y = molecular weight of the band of interest 
 
Linear (semilog): The linear equation is y = a + bx, where a is the intercept 
and b is the slope of the line. 

Note: The linear equation is calculated on the log of the 
molecular weight values.

The R2 value may be used to determine the overall quality of the linear fit. A 

linear regression with an R2 value of >0.99 is considered a very good fit. The 
primary advantage of this method is that it is extremely simple. The primary 
disadvantage is that it will deliver incorrect results if the data are not very 
linear.

Point-to-Point (semilog): No single equation is available for the point-to-
point method. The slope of each segment of the curve between data points is 
calculated independently.

Note: The log of the molecular weight values is used to calculate 
the slope for each segment of the curve.
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Logistic: The Logistic-4PL equation is

where:

x is the mobility

y is the molecular weight

a is the estimated molecular weight at infinity

b is the slope of the tangent at midpoint

c is the midpoint

d is the estimated molecular weight at zero mobility

Since the curve generated by the logistic-4PL regression method represents a 
perfectly shaped S, it might not fit the data very well in all cases.

Cubic Spline: Cubic spline curves are smooth curves that go through every 
data point. The model is a cubic polynomial on each interval between data 
points. In some cases, a spline curve can work well as a standard curve for 
interpolation. However, because the curve is calculated individually for every 
pair of points, it does not correspond to any single equation.



Appendix D: Troubleshooting

101

Appendix D: 
Troubleshooting

Problem Possible Cause Solution

Green LED on front panel is 
off

AC power cord is not 
connected

Connect AC power cord to the imager and an 
appropriate wall socket

Power is off Turn the power switch on

Front panel LEDs remain 
flashing

Firmware is not loading Call Bio-Rad Technical Support for help

Image is not visible on the 
monitor

No sample on sample tray Place a sample on the tray and run the protocol 
again

Image is not bright enough Underdeveloped gel If initially stopped after 2 min, allow the gel to 
develop for 2–3 more min

Red LED flashing on front 
panel 

Sample tray not inserted all 
the way

Push the sample tray into the imager until the 
magnet pulls the sample tray

Door interlock broken Close the door

Bulb fault Replace all the lamps according to the 
instructions in Appendix A

Communication interrupted Make sure imager power is on and the USB cable 
is connected to the PC. Restart the imager

Imaging button is pressed 
on front panel while 
software is not running

The red light stops flashing when the software is 
opened. Press the imaging button again to 
initiate imaging
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Appendix E: 
Mitsubishi P93/P95  
Thermal Printer Settings

Windows
The printer driver can be found on the Image Lab™ software installation CD in 
the Misc directory. 

To set up a thermal printer on a Windows system:
1. Install the printer driver. 

2. Open the printer section in Control Panel.

3. Click the thermal printer icon and select Printing Preferences.
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4. Configure the correct paper size: select 1280 x 1280.

5. Select OK to apply your changes.

Macintosh
The printer driver can be found on the Image Lab™ software installation CD in 
the Misc directory. 

To set up a thermal printer on a Macintosh system:
1. Install the printer driver.

2. Connect the printer to the computer.

To configure the correct paper size:
1. Start Image Lab software.

2. Select FIle > Page Setup.



Macintosh

105

3. In the Settings drop-down menu, select Page Attributes.

4. In the Format For drop-down menu, select the Mitsubishi printer.

5. In the Paper Size drop-down menu, select 1280 x 1280.

6. In the Settings drop-down menu, select Save as Default. 

7. Click OK to save the settings.



Gel DocTM EZ System | Appendix E: Mitsubishi P93/P95 Thermal Printer Settings

106



 Glossary

107

Glossary

CCD: (charge-coupled device) A light-sensitive silicon chip used as a 
photodetector in digital camera systems. 

Colormaps:  Different color representations of a gel image.

Electrophoresis: A technique for separating molecules based on the 
differential movement of charged particles through a matrix when subjected to 
an electric field.

EtOH: Ethanol.

Example precision: The number of decimal places chosen for a 
measurement.

Flat fielding: An average intensity computation that compensates for 
nonuniformities generated by an instrument.

Histogram: Representation of the brightness, or gray value, of an image 
as a graph.

MeOH: Methanol.

Quantitative imaging: Determines the quantity of a protein’s 
components through analysis of the pixel values in a digital image of the 
sample.

Relative quantity: A measurement of a specific band’s relative 
quantity to the total of all identified bands within a given lane.

SDS: Sodium dodecyl sulfate (sodium lauryl sulfate); a denaturant that 
provides a negative charge.

SDS-PAGE: Polyacrylamide gel electrophoresis performed with the 
denaturant sodium dodecyl sulfate.

Tris: Tris(hydroxymethyl)aminomethane; a buffer component.

Tryptophan: An essential amino acid that is a precursor of important 
biochemical molecules indoleacetic acid, serotonin, and nicotinic acid.
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UV-B: The range of ultraviolet light used by the Gel DocTM EZ system.

UV transilluminator: The part of the Gel Doc EZ imager that 
transmits UV light through a sample.
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